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Introduction

Flote is a software application for the high-thrbpgt behavioral analysis. The main
purpose of this utility is to take stacks of imagégroups 5-8 day old zebrafish larvae
recorded with high speed cameras and detect thiation of discrete elements of the
larval motor repertoire.

In the process, Flote extracts a large amountfofnmation about the kinematics of
movement, which can also yield useful insights inétavioral modulation. Flote can
also be used for the much simpler applicationaxking larvae and measuring non-
kinematic features, like position, speed and oaton.

The algorhythms underlying Flote are describedh@sé two articles:

Burgess HA and Granato M. (2007) Sensorimotor gatidarval zebrafish. J Neurosci.
27:4984-94.

Burgess HA and Granato M. (2007) Modulation of imodor activity in larval zebrafish
during light adaptation. J Exp Biol. 210:2526-39.

Flote was written by Harold Burgess in the labonatef Michael Granato at the
University of Pennsylvania. Much thanks to JohodBer from the Department of
Bioengineering for the particle identifying algtm, Jeremy Magland for mathematical
assistance and Hannah Shoch for extensive roadgest

Bugs, both known and obscure remain in the codease let us know if you find
anything egregious. In addition these instructiaresa work in progress, incomplete in
some areas.



1. Installing the software

1. 1. Installation

Flote is written in the IDL programming languageo run Flote, you must have the IDL
Virtual Machine installed on your computer. Thasaifree download, which (currently)
may be obtained from:

http://www.ittvis.com/download/download.asp?seanthg=&radDownload Type=Down
load&ProductVersion=279&Platform=All+Platforms&Dowrad Type=All+Types&sub
mit=Submit

In case the address of the download site changasstsfor 'ITT Visual Information
Solutions' and find the link on their website f@L VM'. Note that the IDL download is
going to install two pieces of software on your garter (1) IDL itself which will operate
in ‘trial mode' for 7 minutes and (2) the free IRIntime platform which will execute
pre-compiled code. To use Flote you only needuhéme platform and therefore do not
need to purchase IDL.

In principle, the code should run under any platfdéor which an IDL Virtual Machine is
available, however we have not attempted to ustharg/other than Windows 2000 and
Windows XP. The minimum hardware we have used 8B RAM with a 2.8 GHz
processor.

Once you have installed the IDL Virtual Machine,kaa directory for the three files,
flote.sav', 'flote_setup.sav' and 'batchan.sBun the 'flote_setup.sav' file. Note if you
have software like SPSS installed on your compuytar,will need to right click on the
flote_setup.sav file and open it with ' IDLRT". i$hwvill create a folder: 'C:\ftrack\' with
various subfolders, used for storing your settiagd in some cases your output files.

In addition, you need to specify three settings:

1. The default video directory. This is where Elatill by default look for video files.

2. The save tracks directory. This is where Huateby default save tracking files. Itis
often advantageous to run Flote on multiple compuite speed up the tracking. If you
intend to do this, make sure that the 'Save trafikettory is accessible from all
computers. The exact path to the directory shbaldpecified. For example for a local
directory it might be 'C:\Share\tracks' and while path to the same directory from
another computer might be 'S:\tracks'

3. A computer identifier. This is only really imgpant if you will use more than one
computer for analyzing data. Each computer shbaleg an name.

When you have entered your settings, presS#webutton therQuit. Alternatively,
press Quit to leave the setup program without nyatifthe settings.



By default, when you open Flote, it displays 4 &&n the middle of the screen. To
change this, place a jpg image in the 'C:\ftraekish' directory.

1. 2. Un/Re-installing

To uninstall, just delete the directory 'C:\ftraakd the Flote.sav files.

For a completely fresh install, delete the diregt@r\ftrack' and the old Flote.sav files,
then run the flote_setup.sav again.

To upgrade to a newer release of Flote (and keegt afigyour saved configurations),
don't delete the C:\ftrack directory. The flotetupesav program will overwrite only your
Default configuration and default paths. This gahare is also useful for giving your
computer a new hame, or changing the default vaaebtracks directories.
Occasionally, depending on the version you areagigg from, this may not be
sufficient and you should then perform a freshalation.

1. 3. Using the Folder Browser

Directory to select

Celect| DnASharedDL codebfish_movementhinstiuctionshEvamplasasr Chare |

[ DR ;I
‘I J D:AShare DL codehfish_movementinstructionshE ramplesh.asr 2

Tizaks D:4Sharet DL codehfish_movementhinstructionshE rampleshdark.

Default tracking and video folders

Video |

Uszer |

[Set] |t

Folders in currently browsed directory

|User settable quick-find folder

Quit, don’t select file

A
T

Catice Ll



1. Select the drive you want (or use the 'Trackgleo' or 'User' presets to quickly
navigate to the target folder)

2. Navigate to the desired folder. Double clickeofolder to enter it. If you enter a
directory with a huge number of files, it can taking time to enter the folder
(especially if they are on a network drive) - avthiss! Double click on the "..." to go back
up a directory. Single click on a folder to sestthe folder which will be selected. You
can always see which folder is the one which walilskelected, by the text beside the
‘Select' button.

3. Press 'Select' to choose the folder besidettierb
To cancel the operation, hit 'Cancel'.

The 'Tracks' and 'Video' folders are the defauttds for storing video and tracks
specified during installation. A third preset 'Uss available. You can set this by
pressing the '[Set]' button when you have choostasaed folder. Occasionally you will
have another option on the top right 'Store' - $leis the folder as the default for the
current type of folder selection operation.



2. Recording Videos

2. 1. Kinematic Analysis of Zebrafish Larvae

Larvae should be recorded using a suitable letsatdheir length is roughly 50 pixels.
Flote will not work well unless the larvae are bbat the same length. Older larvae
(after about 10 dpf) are often variable in lengih either presort ones of about the same
length or use younger larvae.

The recording speed will depend on the applicatidowever, for automatically
identifying motor patterns, the software requitest the recording is made at exactly
1000 frames per second (fps)We generally a resolution of 512x512. Videosust be
saved as a stack 8fbit (i.e. grayscale) JPEGs with% 'quality’ compression.

Lower quality compression (< 50%) leads to sigaifitdegradation in tracking. Higher
guality compression (>90%) yields much larger $ilees resulting in reduced tracking
speed and produces only marginal improvementsaaracy (less than 1% more
‘trackable’ objects).

m M Each video should be saved in its

own folder and the names of the file
stack should be the same as the
QBxk - O - (¥ | & E- folder name PLUS an underscore
Address |) Z:\everythinglos2e07_pzz1_tfdsioff 01 »| [§ PLUS the frame number. The first

T frame should be numbered zero.

File Edit Yiew Favworites Tools  Help

Mame =

He-off_01a_0000,jpg

Meoff_01a_000L.jpg Example: You recorded a 8000

3 off_01a_0002.jpg frame video, which contains 40

M- 0ff_01a_0003,jpg events each of 200 frames. Make a

Sl.nff Ma N0N4.inn folder called 'off 0la' and inside the

: | folder, save the video as a stack of
/8,000 objects 75.4 1B S Jdlocalintranst  JPEGS where the first frame is

called 'off_0la 0000.jpg' and the last frame isecabff 0la 7999.jpg'

If your recording software doesn't permit this nagn¢onvention, videos will still load,
so long as the stack of frames are still in thein dolder and in alphanumeric order.
However image stacks will take longer to load.

2. 2. XYA Analysis of Zebrafish Larvae

Flote can operate in a simpler mode, in which qagition and orientation information is
analyzed. For this type of recording, it is stdicessary to optimize centroid finding (see
below), but not essential to optimize eye-findimgorvature. Resolution is not



important, so long as the position (and usuallgmration) can be succesfully determined
by Flote.

2. 3. Other animals

Flote can also perform simple tracking of otherugpr®of animals, yielding position,
speed and orientation information. Where displaa@ns a reliable measure of
movement, it can also classify individuals as mgwen stationary. For robust tracking,
the recording frame-rate should be sufficient thdividuals move less than half a body
length between frames. For Drosophila, we find i frames per second works well.




3. Setting object detection parameters

3. 0. Loading Videos

Choose: File>Select video directorthen single click on a folder containing a statk o
JPEGS. Click 'Select'. The first image in thelstshould now be displayed and the
message window will display 'First image in foldemd the dimensions.

If there is an error, the message window may ridadsuitable jpegs in folder'. This
usually reflects non-conformity of the filenamedhie convention described in section
2.1, but could also reflect an unusual mode ofrgpjpegs - remember they should be
grayscale. There is a known bug in Flote - if yguselecting a new working directory,
while the graphing window is open it will also geate an error. Just close the graph
window and try again.

For optimal loading, the first file should be numdskzero. However if the video
directory contains a '.cih’ file, Flote recognities directory as originating from a Photron
camera. These video files are saved with thefflesas _000001.jpg instead of number
zero. For such directories, Flote will automaticaldd +1 to the file number. However
in telling Flote which files to load, you shouldllstegard the first frame as being zero
numbered.

If you were unable to save using the conventidentime'="folder XXXX.jpg' then
toggle the 'File>Alphanumeric file order' to be checked. Flote w8ksume that the file
stack is simply saved in alphanumeric order. Whéoads a video, it will each time
make a list of all files in the directory and ogke appropriate subset. This is slower
than when it can assume that frame numbers aradpgdo file names, with the first
frame being zerolf you have any trouble loading videos, the firsthing to try is
applying the "Alphanumeric file order" setting .

If there are a large number of frames in the dingcand/or the directory is hosted on a
remote server, it could take around 30 secondtholSelect directory' window to close
and the first file to display.

Note that images that are not 512x512 are strettth&tthe display. This may affect the
display of tracks and other visual annotations,da#s not affect the actual analysis.

3. 1. Finding the head centroids.

|H ead [ocate parameters

o 12
The 'Head Locate' part of the main window allows yo : ol 4 =1 e
to adjust parameters for finding the head centroids mliﬁgizeJ E.Iie;éiﬁ _I

AU A] 2] et

Diarneter Denzity



Click theBpassbutton. This shows the bandpass filtered imagewhll be used to find
head centroids. The bandpass controls are theeMaie' and the 'Object size'. Objects
smaller than the 'noise’ size (in pixels) or lartp@n the 'object size' will be smoothed
out. For larval fish whose length on the imagatisut 50 pixels,
using a noise=3 and object=12 sufficiently blurs ¢lyes and
head into a single object.

Now play with the 'diameter' and 'density' funcsorrhese are thresholds. Only objects
whose diameter and intensity respectively are faitggn these numbers will be
recognized as head centroid positions. For ldishlrecorded at the recommended
image size, diameter=13 usually suffices. Densitydepend on your illumination. We
generally use density=100.

To check your settings, make sure that the pararbetelay—Head
Positionsis on, then click 'Heads'. All the fish shouldrbeognized, with a
crosshair showing the position of the head centi@migach fish.

For more information on the particle identifyingatithm implemented see:
Crocker, J. and Grier, D. (1996). Methods of Dilgiteleo Microscopy for Colloidal
Studies. Journal of Colloid and Interface Sciehb¢®, 298-310.

3. 2. Finding the body curvature [Body segment parameters Contour|
Segmentz: (03 1
The body segment part of the main window contains _ Kl >
. . Max bend: Iﬁ Seq. Length
controls for changing how the larval curvature is
modeled. Eyefind  [1.4.3400

The body is modeled as a series of (at least) s@gments. The number of segments
can be set in the 'Segments' field. For trackamgdl fish, we use 3 segments. The length
of the segments is set using the 'Seg. lengtlérdtidr. Two factors are important - the
first segment should end just before the caudaémity of the swim bladder. The head
begins to bend at around this point, so the seghaegth needs to end here.
The second factor is that depending on your contitaes tail will begin to

thin out and be hard to recognize. If the segmarggoo long, the third
segment will be 'jumpy'. Generally a segment lerftll or 12 is suitable.

The 'Max bend' parameter is not generally changescthe | Tracking Analysis Configur
segment of the circle searched for the 'next segmehis is o [ o
set at 220, giving a maximum segment to segmenéarig Start batch tracking
110 degrees.

v Rapid tracking

There are four methods for finding the segmentschvban search lost points

be selected under the Trackimgnu.

Broad search figld
Follow eves

Crrient line density:

v Orient poink density
Crrient elipse
Cwerlapping contours
Lew Conkrask
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Orient line density the default and usually most reliable. Thismoetmeasures the
density of bars radiating from successive initiagomints and identifies the most intense
bar as the continuation of the body axis.

Orient point density Searches only for the most intense point aetiteof bars radiating
from successive points on the body. This is sametimore accurate in images with
noise, for example when larvae are gridded in & baptrast array.

Orient ellipse- Fits an ellipse to the centroid using David Ragls fit_ellipse routine
(www.dfanning.com) and extracts the orientatiomthef major axis of the fitted ellipse.
The ellipse is fit using a box around the centreltbse width is specified by the ‘radius’
slider. This is not intended for larvae fish, muguite good for measuring eye
movements during optokinetic assay.

Overlapping contoursUses overlapping bars to measure body curvaflings is not
useful for larval fish and is intended to allow reegement of the orientation of other
organisms. The differences are that the first oaiggon bar is centered on (not emanating
from) the centroid. Consequently the orientatiange is from O to 180 degrees not a full
360 degrees.

Other examples:
- *‘* v
: L F s

In addition there is a Low Contragption in the "Tracking' menu. If your light soaris
weak and contrast is poor, low contrast tweakgitigedensity algorithm to improve
curvature analysis.

3. 3. Finding the eyes

The 'Eye Find' parameter is by default '1,3,3,4P0,These numbers refer to the
parameters passed to the bandpass function fan§jreyes: noise size=1, object size=3,
diameter=3, density=400, search radius=12. Tokctiet these parameters work for
your video, set the 'head locate' parameters Wwéhke settings. While the whole video
field will probably become covered in 'head’ chatkrks, there should be
marks clearly identifying every eye of every fisim. poor illumination you
might need to reduce the density to 100 for thes égdvye correctly found. If
the image of the larvae is small, you might neegkthuce the search radius.
The search radius needs to be larger than thetahpec

11



By default, Flote only finds eyes in the first framthis is useful to exclude larvae which
are lying on their side or contrast elements wihihnot larvae. However, by finding the
eyes in every frame, Flote can also determine venette larvae maintain an upright
posture throughout their movement. This slows doaoking, but can be enabled by
selecting Tracking>Follow eyes

3. 4. Setting image regions

Often you will want to exclude contrast elementthat

edge of the image, for example the edge of therdaug e
arena. Two options in the 'Image subset' areavaltny  ‘wels: [0 0
to do this. The 'Frame' field lets you specifyumnter of | na

pixels from the edge to exclude - by default itisageD. Frame: [0 Rladius

The 'Radius’ slider excludes points outside aeircl

centered in the middle of the image, whose raditlf the image width less the value
of the radius slider. This is useful if you arearding inside the whole area of a Petri
dish.

The 'Wells' field lets you divide the field into Xnby X series of sub-fields, where each
sub-field is expected to contain just one fishr &wample, set 'Wells' to 2 and press the
Headsbutton. You'll see a 2x2 grid on the field. Dwyitracking, each of the four
squares is assumed to contain a single fish. Hipheielements are identified, only the
darkest object will be analyzed. This is usefih# subdivisions correspond to
individual wells in which fish have been placedlisloften difficult to prevent the 'Heads'
algorithm from identifying parts of the well asvae. However, so long as the larvae is
the darkest object in the sub-field, it doesn'tterabnly that larva will be analyzed. By
default Wells should be set to '0', indicating tietre is no division of the field and that
every fish identified should be analyzed.

If you set 'Wells' to 1, only one fish in the whdield will be analyzed. This can be very

useful if you are tracking adult fish where both tiead and the swim bladder are
typically found as 'heads', but the actual heathiker.

3. 5. Excluding false contrast elements

Contrast elements are often misidentified as laraeluding these is critical to getting
good tracking analysis. Ensure larvae are in etgn water with no dirt floating
around. Avoid imaging the edge of the testing are@nce this is optimized, the main
three tools you have against this problem are:

1. Setting the image regions to exlude regions faibe contrast elements (see 3.4)

2. Adjusting the head centroid parameters so Hia¢fcontrast elements are not
identified as fish

12



3. Adjusting the eye-find parameters so that fatsgrast elements which are identified
as fish, do not have 2 eye spots identified. Tieéseents are then later able to be
excluded from analysis.

4. Tracking a single video

4. 1. Loading the Video

Load in the frames you want to track. Select -hil®ad subseand | 1L M=l B3
in the box that appears enter the number of tiseffiame in the trial,
and the number of the last frame in the trial. ©peon 'skip' allows

IIII
you to only load every Xth frame. In general le#lvie at 1 - all Last frame: Iiﬂg
|1

First frame:

subsequent kinematic analysis for larval zebraksluires videos to i
be performed at 1000 frames per second. P

Tnial:
For example, if each trial was 400 frames, anddlder contains

8000 frames (20 trials of 400 frames) and you watdok at the
third trial, enter 800 beside 'first frame', 119%ide 'last frame'. Load | Cancel |

Then clickLoad.

Alternatively, if the each folder contains onlyiagle trial (for example a 1 second long
recording of 1000 frames), after selecting the wagldirectory you can choose
File—Load whole directoryand the full 1000 frames will be loaded. Memaimniting
but a computer with 2 Gb memory should be ableaaol land track at most around 2000
frames. Typically we analyze 100-400 frames ().&.to 0.4 sec).

Large videos, especially when transferred fromnaote computer can take several
seconds to load. You can see the progress ofrigadvideo in the dialog box above the
image.

Check that the video has been loaded correctlye slider bar above the image shows
the frame number being displayed. If you movediiger bar, the frame number should
change and the appropriate image displayed. Tyotp&awhole video, press tikevd
button to the right of the slider bar (and to pitalyackwards, press thgack button to the
left of the slide bar). Thiame-rate slider sets the 'skip' - by default its set at 5,
meaning that playing the video will display fram®&,Q20,15 etc. For very long videos,
you will likely want to adjust this to 10 or 20.0FFsaving videos (see section, ) you will
want to set this number to 1 so as to save evamgdrin the video.

When you are finished analyzing a given trial, yan select File>-Next subsebr click
theNext button to retrieve the next trial. Conversely Ehev retrieves the earlier set of
frames. Example, if you loaded the 400 frames fimme 800 to frame 1199, selecting
the next trial would load frames 1200-1599, wha&esting the previous trial would load
frames 400-799.

13



Once you have loaded the first video, the-Filebad subseimenu allows you to enter a
trial number. If you specify a trial it over-ridasy text in the 'first frame/last frame' box.
For example, if each trial is 120 frames, and yalec trial 12, then frames 1440 t01559
will be loaded.

4. 2. Setting Tracking Options

There are two methods of tracking, selected byliogghe : , ,
: ) ) : . | F
Tracking—Rapid trackingsetting. The 'slow' method (option o] Srebily il

unchecked) is a simple implementation of the tragki gf;ftpbi‘zichht:;iﬁ';g
algorithm of Crocker and Grier. The 'rapid’ metlfoption

checked) uses a similar approach (connecting rteares v Rapid tracking
neighbors across frames), but simply institutescallsearch Search last points
across frames, after identifying initial object jtiosis. For all o cEEiEn e
applications we have tried, the 'rapid' methodsiaecurate and  Follow =ves
much faster. It is possible that in a very crowdleldl, the it fime A

'slow' method would work better, but in generalgk&apid tracking on. Rapid tracking
has a maximum allowed object size of 25, or 5@éf'Broad Field Search' is checked -
for larger objects the slow method is necessary.

There are two other options under the Trackmenu, both of which are left unchecked
by default. They only work under Rapid trackingdeo These options are not useful for
most applications and should usually be left unkbéc

Search lost pointsif the larvae becomes fainter during the trial €xample, due to
waves of water passing across it or fast movenméraducing a slight blur) the density
threshold will be automatically reduced until thetcle is located again. Having this
option on can greatly slow down tracking - howether fact that it is doing so means that
more larvae are being successfully tracked. Youtgareducing the initial '‘Density’
threshold to prevent larvae being lost.

Broad search field by default, during rapid tracking, a local sésfor the nearest object
in a 50 pixel box around the position of the objadhe last frame. If this box is
checked, the search is expanded to 100 pixelss i$hiseful when:

1. Tracking is being performed for reasons othantkinematic analysis, where the
recording speed might be less than 1000 framesideand the larvae move further
between frames.

2. You need to set an object size greater tharV2sh the '‘Broad Field Search' checked,
you can have an object size of up to 50.

Rather than manually set the object detection eauking parameters every time, once
you are happy with the parameters, you can saveahigguration by selecting
Configuration—~Save this config Give the configuration a name and press 'Save'.

14



reload the configuration, either select ConfigunatbLoad Tracking Configr
Configuration—~< Saved Configuration Name> .

4. 3. Tracking a video

With a video loaded and all options set, click Tmack button. In the dialog box above
the video, you should see the progress of theitrgck-irst the object positions are found
and linked into tracks. Second the orientatioraxth object is determined across frames.
Tracking is finished once all objects have beeardgd - for example the dialog will read
'Orienting item 3421/3421".

If you are going to load and track many trialssiconvenient to set the FieTrack on
Loadoption. When set, after pressing text or Prev buttons, Flote will automatically
track frames after they have been loaded.

4. 4. Displaying tracked data

The Displaymenu controls how the video is displayed on titeest, annotating it
selectable options.

The following options are toggle switches, turnedand off by selecting the option:
Tracks- displays the path followed by each object.

Head positions displays the head locations.

Eye Positions displays the eye locations.

Head Orientation displays the first (i.e. head) segments.

Body Contours displays all the segments.

Background displays the video (leaving the annotationsatta

Number larvae displays the number assigned to each object.

Neighbours displays the nearest neighbour to each object.

Orientation trail- shows a 'trail’ of the orientation in the praxsdlO frames.

The Head Shapgubmenu contains various options for designatiegiead centroid.
The Eye Shapsubmenu contains various options for displayiregeipe positions

Selecting Setup Colopens a window in which the color assigned tohtbed, eyes,
tracks, numbers and three body segments can beltedt The Multicolor track$oggle
over-rides the color assigned to the larval nunaloer track to give each larva a
distinctive color. The Grayscateggle over-rides any color selections with a diefa
black and white palette.

The Selected Objesubmenu controls how the selected object is
displayed:
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Zoom and Center Toggles whether the zoom window keeps the heattaid of the
selected object in the middle of the window.

Highlight - Toggles the display of a circle around the hefathe currently selected
object.

Mask others Toggles the display of the head and body segsrardll objects, or just
the selected objects.

Fix Rotation- Rotates the zoom window so that the head o$étected larva is always
facing to the left. This only operates if the 'Aopand Center' has been selected.

Copy to file- Toggles saving of the image to an output fisery time the image is
changed, the current video display is saved taf'dile in the 'C:\ftrack\images\' folder.
This is very useful for making annotated videogn@y toggle this on, then press the
Fwd button beside the slider at the top of the imageery frame will be annotated and
saved in order. Remember to turn this option dffthere are files already in the
'C:\ftrack\images\' folder, new files will be nunmbd after the existing files.

Annotate Time SeriesFlote can annotate the time series data ontantdia window

and/or the zoom window. First toggle on Displafknnotate—»Time serieghen select

the main or the zoom window to be annotated wightiime series data this is currently
being plotted (see section 6.) It is not posdiblselect a subset of the time series - every
frame is included in the annotation.

Annotate Stimulus It is sometimes useful to represent the frameghich stimulus
conditions changed. To do so, toggle the Displ@ynotate—Stimulus then select the
main or the zoom window to be annotated. Next shdoisplay-Annotate—Setup
stimulusand enter the first frame and the last frame tdkrttee stimulus.

To make the annotation larger, for example if yoai@anning to save frames and
compress them subsequently to make a movie, tagglke
Display—Annotate—~Double Thicknessption.

If 'Use External' is selected then external IDL €dlcalled to annotate the image. This
is for future use only.

To zoom on part of the window, hold down the rigiduse button and drag the mouse
across the area you want to highlight. A zoom wmavill appear, with an expanded
view of the region. The physical size of the zoemdow is fixed on the x-dimension
(i.e. the zoom window is 500 pixels wide). Soalyselect a small horizontal region for
zoom, the magnification will be large. The y-dirsgm of the zoom window is simply
scaled proportional to the scale factor for themehsion.

You can select a 'standard’ zoom window dimensyochiecking one of the options in
DisplayDisplay—-Zoom Size This will magnify a window of 100x100 or 200x2pxels
into the 500x500 pixel zoom window. The top ladtrer of the zoom box will be where
you right-clicked.
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After tracking, you can right click on a larva tghlight it and a zoom window will
appear with the selected larva in the center. n@this automatically sets the Zoom and
Centeroption, so that the larva will remain in the certethe zoom window while it
moves.

Left clicking inside the zoom window will give ydhe pixel location in the message
window. Dragging with the left mouse button depezsgives the dx, dy values and
distance in the message window. This can be ugmfahaking length measurements.
Right clicking inside the zoom window puts the stde point in the center.

Note that when Copy to filss toggled on, the zoom window will also be savétiis is
useful for making enlarged videos of a part offiakl.

4. 5. Saving tracking information

You can save the tracked information for a vide®élgcting Tracking>Save Tracking
Eile. A file containing the position and orientatigridrmation will be saved in your
default 'save tracks' directory (see section 1) wie file name 'track_eXXX.sav' where
the XXX corresponds to the number of the videdmdirectory.

Tracking files are proprietary IDL data files tlzain't easily be opened or viewed. To
convert these files to tab-separated text filesifapened in Excel) select
Tracking—Convert tracks to textChoose the directory containing the track fdes
press OK. Files in the selected folder will beiedpo the 'C:\ftrack\' folder, with a ".txt'
suffix. These files contain 10 columns. Each sp&cifies the position and orientation
of a single object in a single frame of the video.

Fish - the number assigned to each object in the video

Frame - frame number for that object

X - X position of the object in that frame

y - y position of the object in that frame

mass - density of the object

radius - a measure of the object size

eccent - a measure of object symmetry

orientl - the orientation of the first (i.e. head) segmafithe object
orient2 - the orientation of the second (i.e. midbody)nseqgt of the object
orient3 - the orientation of the third (i.e. tail) segmenthe object
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5. Batch tracking multiple trials

Flote is designed to automatically track multiplals. First, to be clear on terminology.
By 'trial’ or 'event' we mean a single short viggpically 100-400 frames) which records
the response of the fish to one stimulus. Gengralfiven group of fish are exposed to
multiple stimuli. Flote expects that a folder aining a stack of JPEG files with
continuous numbering, in fact represents the meltipals.

For example, folder 'DRUGA_PO01' contains files 'DRAJ PO1_0000.jpg’ to
'DRUGA_P01_7999.jpg'. In this case, we have tedtad A, with plate #01 of fish.
The 8000 files might be 80 trials of 100 framestpiat, or 20 trials of 400 frames per
trial. All these need to be individually trackedsulting in 80 and 20 tracking files
respectively.

'DRUGA_PO01' was likely only a single data pointlodé whole experiment. Thus, the
folder 'DRUGA_PO1' itself is inside a larger foldmmntaining all the data for a given
experiment. For example, you have a larger folsartle 05212006 containing six
folders ' DRUGA_PO01', 'DRUGA_P02', 'DRUGA_PO03', 'CORDL_PO1',
'CONTROL_P02' and 'CONTROL_PO02'. Each of the slddrs contains 8000 frames,
representing 40 trials each of 200 frames. In tbtn there would be 6 x 40 = 240 trials
to track.

5. 1. Setting up batch tracking

Rather than load each video, press track, thentbaveacking file, you can set Flote to
batch track the whole experiment. Select TrackhSgtup Batch Trackingo setup
batch tracking.

] Setup Batch Tracking

- | [F\052407_p220_e01_thde |

Containz {020 folders, each with |2|:| events of 400 frames.

Autor | — |||:I:'\Share'xNew Tracks\052407_p220_el_ide|

Configuation: I dont zet j

s Listl Add | Add Tn:||:|| SaveListl Qi |
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First, press 'Source'. The 'Source' is the ladgectory which contains all the video
folders. Note that in the setup program, you gaecsy default locations for the source
and target directories.

In the example above, you would select the folftrtle_05212006'. Press OK. The
selected folder will appear in the box besideSbercebutton. Check that this is the one
you meant to select. Flote will count the numbeotmlers inside the selected folder. In
the line below it should read

'‘Contains @olders, each with ...'

Next, you need to specify how many events/triagsiaside each folder, and how many
frames in each trial. Flote assumes that somewhehe name of the folder is a string
designating the experimental protocol in the fofiti xxx_" or "_Dxxx_" (where xxx
are numerals). The first time you use a protogml, will need to enter the number of
trials and frames. However it will remember thtisgs for each protocol for future
experiments. You can of course over-ride the rebeed settings (which will then be
replaced). If no string designating a protocdbisnd, or if the protocol hasn't been used
before, Flote will guess that each trial is 12000 frames long and enter these values
accordingly. But this is likely wrong, you will pbably need to enter these numbers
yourself.

You must specify a directory where the trackingdiWill be saved. This can be done in
either of two ways. Either press tharget button and choose a target folder. This will
then be entered in the box besideTaeget button. Alternatively, just click thAuto
button. A new folder, with the same name as tigefocontaining the video stacks, will
be automatically created in your 'save tracksctiing (see section 1 above).

To have different experiments tracked with différeonfigurations, choose a preset
configuration from the drop-down list. Alternatiyeselect the first option '[User set]' to
have the tracking not alter the selected settingbe main window. Note that if you
have two experiments in the list where the firgcfes a configuration file, and the
second is at '[User set]’, then the second willtheeconfiguration loaded when the first
experiment is tracked.

Finally, press 'Clear list' to remove any tasks yles may have specified in the past.
Then click 'Add’ to add this task to the bottontrad list or 'Add Top' to add this task to
the top of the list. It should be displayed in tight-hand box, with the input directory,
output directory, number of events and frames penecorrectly specified.

If you performed more experiments you'd like takiayou can add these to the task list.
Just don't click 'Clear list' in between - you caake a list of folders that should be
processed. This is useful if you want to recotdlay, then let the tracking process
everything overnight. When your list is complgigess 'Save List', then 'Quit’. If you
press 'Quit" alone, the list will not be saved!
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The 'Filter' field lets you specify which foldersivbe tracked. If blank, all folders are
tracked, otherwise only folders containing the iaxhe ‘filter will be tracked. As
tracking is done in an alphanumberic order of fiddénis can be useful if you would like
to see data from particular trials quickly.

5. 2. Running Batch Tracking

Make sure that your tracking 81 Batch analysis

&l Batch Analysis Ol =
parameters are correctly set. The sal . : x|
tracking parameters are applied to IZ:"-.E"-.-"EHYTHlNG"-.EIEE#D?_F'EEEI_ED'I_TLFDE"-. (141)
every experiment in the batch list. ITarget containg: 30 Completed: 30

When you are ready to start, select
Tracking—Start Batch Tracking A
batch tracking window will be
displayed. This shows what trial is Fun  Pause  Guitth  Quit  Run—Quit
being processed and has several
control options, selected by hovering the mouseralloe field. Flote will not respond
immediately to selection of these control optioiifst-is in the middle of a tracking
operation, you need to wait until it is complete.

Susatting new folders.
Tirme gince lagt Orin.

Batch tracking can be started while you are stitording videos. Once everything on
the original list is finished, the source foldersese you are saving video files are re-
checked every 30 seconds to see if new video feldave appeared. If so these are then
tracked. This is useful if you are recording o @omputer and have another free to
start tracking.

The batch control options are:

Run- continue batch tracking.

Quitlh- track until everything is finished. After 1 han which no new videos are
saved in the source directories, quit.

Quit - Quit now.

RunQuit- track until everything is finished then quit.

If you have several computers networked, you camsitiple computers to analyze the
same video files. Setup batch tracking on eachpeen, making sure that directory in
which tracking data is saved is the same. Youtlean initiate batch tracking on multiple
computers - each computer will first look to sethd relevant tracking file has already
been saved. If so, it will skip to the next sefrafnes. For large experiments, having
two or three computers analyze data can dramaticediease the speed of tracking. As
a rough guide, analyzing an experiment with 108dd, each containing 8000 frames
(eg 20 trials of 400 frames) should take two coramutvorking collaboratively about 10
hours.

In addition to the tracking files, the output fald®ntains a file log.txt'. This file, which
can be opened by a word processor, contains infmabout the identity of the
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computer which performed the tracking, time anciilebf the configuration used. Each
time the tracking started, the log file will be @beld with this information. If multiple
computers are used, they will all write to the tegfile, allowing a quick check that the
configurations were indeed the same. Network [@gés may prevent some computers
from writing to the logfile, in which case you wile notified of the error when tracking
begins and the log file will not be updated.

To analyze the files created by batch tracking,ssetion 8.
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6. Analyzing Time Series Data

After tracking the video, left click near the laryau are interested in. The larva should
be designated by a circle around its head locgaesuming you have DisplaySelected
Object-Highlight turned on). The dialog box will display two linesinformation:

1. The Pixel location in (x,y) coordinates clickaal its intensity.
2. The number of the larva selected, its (x,y) dowtes and orientation in the frame

selected.

A 'Time Series' window will open to the right oktimain window. The time series

window contains information on selected paramdtarghe highlighted larva. The value

of each parameter across frames is shown. Iiimdow is not desired, to prevent
screen clutter, you can toggle its visibility usMtindows—Hide Time Series

2] Time series:
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6. 1. Selecting time series data fields

A variety of parameters can be
displayed in the columns of the
Time Series window. Select whic
parameters are displayed by
opening the AnalysisSelect
Paramswvindow.

Click the checkboxes you want,
then presSaveandQuit. The
Default buttons will mark two
different subsets of the checkboxe
that are typically useful. The
checkboxes available are:

#ill Set Analysis Parameters

[v i position

[ Pasition

™ Orientation axis 1
[ Origntation axis 2
[ Origntation awis 3

[ Orientation axis 4

V¥ Curvature
[ Abs(cureature)

[ Tail curvature

[T Meighbour distance

[T Meighbour arientation offzet

¥ Change ¥ poz
[ Change ' pos

[~ Change avis 1
[ Change axis 2
[T Change axiz 2
[ Change axiz 4

¥ Change cureature

[ Change abs(curee]

[ Erightriess
[ Radius

[ Movement

[T Experimertal

[~ Trend awis 1 [slope)
™ Trend axis 1 [chi)

¥ Trend curvature [slape]

W Trend cureature [chi)

Default Set &

=10l

[~ %%t
[~ v -t

¥ 2u1- dxitl)
I~ 221 mod 90

™ fx3-4x300)

| Save |

Default Set B

| Quit |

[T Eccentricity
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X Position - x coordinate of the object.

Y Position - y coordinate of the object.

Change X Pos - movement in x position from the previous frame.

Change Y Pos - movement in y position from the previous frame.

Movement - total movement in X,y position from the previdtame.

Experimental - not yet implemented.

X-X(t0) - x coordinate relative to initial position (iie.frame 0)

Y-Y(t0) - y coordinate relative to initial position (iie.frame 0)

Orientation axis 1-4 - orientation of body segments 1 to 4 respectively

Change axis 1-4 - change in orientation of body segments from &damframe
(maximum change is 180 degrees, or 90 degrees axextapping contours are used).
Trend axis 1 (slope) - slope of the linear fit to the head orientationction.

Trend axis 1 (chi) - chi-square error of the above function.

Ax1-Ax(t0) - head orientation relative to initial orientation

Ax3-Ax3(t0) - tail orientation relative to initial orientation

Ax1 mod 90 - head orientation converted to a 0-90 degreeeang|

Curvature - sum of the angle between segment 1&2 and thie &regween segment 2&3.
A positive value means a leftward bend (be suhtk that your optics do not invert
the image).

Change curvature - change in curvature from frame to frame

Trend curvature (slope) - slope of the linear fit to the curvature funatio

Trend curvature (chi) - chi-square error of the above function

Abs(curvature) - sum of the absolute value of the angle betwegment 1&2 and the
absolute value of the angle between segment 2&3

Change abs(curve) - change in the abs(curvature) from frame to frame

Tail curvature - sum of the angle between segment 2&3 and thie dregween segment
3&4

Neighbour distance - not yet implemented.

Neighbour orientation offset- not yet implemented.

Brightness - density of the head centroid

Radius - a measure of the size of the head centroid

Eccentricity - a measure of the symmetry of the head centroid

6. 2. Saving time series data

The values in the Time Series window can be sayed b

selecting Analysis>Save Time SeriesThe default file |Time Series Analysis Biat |
is 'C:\ftrack\singlefish.trk'. The output file @stab
separated text file that can be opened in excete N Frames| [0~ ta[355 | Y« [200
that if a file of the specified name exists, itwibt be Freq Fiter (Hz) | Box |
over-written, but the information appended to thd e

of the file.
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Not all frames need to be saved. Inthe TimegS&mnalysis' area of the main window,
the frames that will be saved are specified - #fawlt is '0' to '399'. By changing these
numbers, only the designated subset will be saved.

6. 3. Plotting time series data

To plot the time series, click on the column that yvant to plot in the Time Series
window then press thelot button in the ' Times Series Analysis ' area efrtfain
screen. A graph of the parameter against timeapitlear in a new window. The title of
the graph is the parameter being analyzed. Fanpla

i

Z0C.C00C0C 103 200 300

IR Vii7i

The vertical red line with the number at the botiodicates the current frame and the
value of the parameter plotted in the current frame

Selecting a frame Left clicking inside the Plot Window will chandiee frame displayed
on the main image screen to the frame selectdtkiplot. To plot a different parameter,
simply click on it in the Time Series Window. Tre=l line in the plot window shows the
frame selected and the value of the parametertsdlat that time point.

Setting the Y-axis: To change the Y-axis of the graph, enter the ddsialue in the box
'Y-ax.'. If a single number is entered, the Y-agiffom -value to +value. If two
numbers are entered (eg '0,200") the Y-axis widteto those values. If you enter a
blank in the box, the Y-axis will be automaticatigt, using the maximum and minimum
values of the parameter respectively.

Setting the X-axis: To change which frames are plotted, enter newegailn the 'Frames'
fields in the ' Times Series Analysis' part of thain window. To set the x-axis to go
from zero to the maximum frame number, click thrankes' button.

Calculating gradients: Holding the left button down and dragging withie Plot
Window produces a light blue line showing the frantesre the dragging commenced.
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At the top of the light blue line is a bracket shogvthe number of frames and the
difference between the parameter value at the hegjrand end of the drag. The
gradient of linear fit to the region between thaebline and the red line is calculated and
shown as "m=". For convenience in copy-pasting other documents, this value is also
displayed in the message window.

As it is often useful to find the gradient for th@me time window across larvae and
framesets, the red-blue window is remembered wioerciick on new larvae or load new
video sets.

Due to a quirk in the way IDL handles interactiveaows, having a time series graph
open usually interferes with attempts to select@meh a new set of frames. While there
is no problem click the 'Next' or 'Prev' buttongj&t the adjacent frameset from the same
folder, attempts to select a new folder for analysing File->Select Video Directory

will sometimes fail. If this is a problem, clogeettime series graph before opening a new
folder.

6. 3. 1. Smoothing time series data

There are three ways to smooth the time series dRitght clicking inside the Plot
Window superimposes the Fourier smoothed tracbléck) with frequencies greater
than 100 Hz removed. Right clicking a second tanews only the Fourier smoothed
trace - in this condition the text at the bottonthad vertical red line shows the value of
the Fourier smoothed trace. This is useful becthes@00 Hz smoothed data set is used
by Flote for determining movement episodes.

Entering a number in the 'Freq. Filter (Hz)' boowk for Fourier smoothing at the
desired frequency. When anything is entered irbthe the zero frequency component is
also removed. When a single number is enterddeimbox, everything above that
frequency is also removed. When two numbers aeyexhseparated by a comma,
frequencies below the first number are removed,feggliencies above the second
number are removed.

Entering a number in the 'Box' box performs boxaaraging of the trace, using a

window of the number of frames entered in the bBar example, is 3 is entered, then
the value at a time t becomes the average of, t+#1t
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6. 4. Position and Orientation

Orientations in Flote are in degrees, wif

b

0 being horizontally to the left. The x,)} [015 1 2]

positions start at the bottom left of the
screen. After tracking a larvae, left
clicking on it brings up its number,
centroid coordinates, orientation and
orientation relative to a set point
(‘AVec') in the message window.

You can set the target point for the
'‘AVec' measurement by choosing
Analysis—Misc Parameterand setting
the X,y coordiates appropriately. This
number is between -180° and +180°,
with negative numbers meaning the
target point is to the right of the fish ang
positive numbers meaning that it is to it
left.

0 Owo—

[0,0]

A

[512.512]

90

——ea@ 180

[512.0]

For example, after loading and tracking a videa glick near a larvae on the screen.

The message window might now display the followexj:

| 001 (163.1,232.9) Orient:263.3 AVec: -117.0

This means that you have clicked on larvae #1x,itgosition in the current frame is x-
163.1, y=232.9. Its absolute orientation is 268aBhost exactly upward), while its
orientation relative to a target point (in thise€§s12,0], the lower right hand corner) is -

117.0°.
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7. Kinematic Analysis - Single Trials

Flote uses the raw data on position, orientatiahkaody curvature to automatically
classify the type of motor pattern representeddmhenovement event. This is the main
purpose of Flote - to facilitate observer-indeperdeigh throughput analysis of
behavior.

An important warning - behavioral classificationngskinematic analysis igery

sensitive to the tracking and analysis parametBefore embarking on large scale video
recording, batch tracking and kinematic analysis, crucial to spend several hours
manually loading videos into Flote, tracking antidating the behavioral classification.
If this is optimized, you should be able to geaiatia very low rate of mis-classification,
less than 1 in 20, and those mis-classified ev@misild be ones where the observer
might also be uncertain.

Another key point is that because behavioral diassion relies on the kinematic
properties of movement, results obtained from amslgf mutant or drug manipulation
need to be carefully analyzed. It is imporantuie iout that the effect is not a change in
the kinematics of a movement such that it becomeschassified. For example, when
analyzing the twitch twice mutant response to CEldsh stimuli, we were surprised to
see that they had a reduced frequency of O-Bemebnsg and an increased frequency of
J-Bend responses. However on careful inspectidheofideos and kinematic data, it
was clear that O-Bend kinematics are slowed dovwwtisuch that the behavior now
looks like a J-Bend. Thus for analysis purposeaggregated O-Bend and J-Bend
results.

Finally, while kinematic analysis and behavioralsdification in Flote works well, the
details of movement kinematics are not accuratsdoot maneuvers. This is because
scoots (slow swims) are initiated with an extrenfalg flexion of the distal tail, which
Flote does not accurately measure. Thus Floteiémtty identifies scoots only during
the second peak of the sinusoid - so kinematidldethscoot movements are not
reliable, although the classification as a scoatilsaccurate.

7. 1. Setting Behavioral Thresholds

First, you need to setup the thresholds used foaweral analysis. Select
Analysis—Setup Behaviors The fields are:

Analyze from frame - usually set to zero, meaning that frame 0 iditseframe analyzed.
However you can set this to a larger number if gminot interested in movement events
before this time.
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Simulus at frame - if there is a stimulus, you should enter thenieanumber when the
stimulus began (this is an absolute number, nativel to the first frame used. So if the
stimulus was at frame 210 and you decide to andigne frame 200, you should set this
value to 210, not 410).

MAX S.C limit (ms) - the window, in milliseconds, from the stimuldsiring which
movement events are considered SLC startle respoméate that not all events initiated
during this window will be classified as SLC respes, only those with sufficient bend
angle and/or angular velocity. If no startle resg®Es are expected, set this number to O.
Depending on temperature, this number is betwee20lias.

MAX LLC limit (ms) - the window, in milliseconds, from the stimuldsiring which
movement events are considered LLC startle resgorSEC responses are designated
first, so if a response occurs within the SLC tiimat, it will be classified as a SLC
response. If a response occurs after the SLClimm#g but before the LLC time limit it
will be an LLC response. Only responses whichianger than the scoot/turn threshold
(below) are considered LLC responses. If no gtaetsponses are expected, set this
number to 0. Generally, this number is set asthe of the recording window.

Scoot/Turn thresh (deg.) - The maximum curvature for a scoot (generallypB80
degrees depending on temperature) before it becarcasdidate for a turn/C-bend.

Turn/O-Bend thresh (deg.) - The maximum change in head angle for a routine thefore
it is classified as an O-Bend (generally 95 degrdepending on temperature).

Distance Integral (ms) - The frame interval for summing displacementdttulate the
distance. For example if this is set to 1, théatice is calculated by summing the
movement between frames for all frames. |If itdste 5, distance is calculated by
summing the movement between every 5th frame.

Eyes - The number of eyes detected for the larva tmbleded in the analysis. This field
should be set as [minimum number of eyes],[maxinmumber of eyes]. For example
setting the field as "1,2" will include larvae detd as having one or two eyes as
included. Generally anything with more than twe®ys not a larva and should be
excluded from analysis. Larvae lying on their sitle seen as having a single eye and it is
often useful to exclude these by setting this patamto '2,2'.

There are also several toggle switches under Péeagne

Ignoretrack errors - If a large jump in the head angle or body curk@bccurs, this
generally indicates a tracking error. Similarfyailarva is very close to the edge of the
recording field, a tracking error is generatedr tartle analysis, we generally set this
toggle on ; for swimming analysis we leave it off.

Ignore swimmers - The software attempts to detect larvae movirfgrieehe stimulus
frame is reached. If this toggle switch is setsthlarvae are indicated as 'swim'. Ifitis
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not set and there is a distinct movement initiabefore the stimulus frame, the
movement will still be classified. We usually & to on.

Ignore drifters - Flote detects larvae with an above thresholgldcement before the
triggers. In many cases these larvae are swimandgcan be excluded using the ‘ignore
swimmers' toggle. However occasionally larvaesamgly drifting in which case they
can be excluded or included in the analysis ugigtoggle. If this toggle switch is set,
these larvae are indicated as 'swim'.

Strict SLC kinematics - If set, responses are only classified as SltBey have a peak C1
angular velocity of greater than 18 and a C1 donadif less than 10. We usually leave
this off.

Strict SLC latency - If set, responses are only classified as Sli@eir latency falls
within the 'MAX SLC limit' (specified above). Wénaost always set this to on.

After setting the parameters, save them, using¥+8et If this parameter set will be
used frequently, then save it as a configuratismgiConfigs-»Save New Config In the
dialog box, give the configuration a name and ptiessave button. Next time you open
the Setup Behaviors window, your configuration dtidae present under the Configs
menu. You still need to save it using Fi#&etbefore closing the window.

Finally close this window using FHeQuit.

7. 2. Selecting Analysis Method Kinematic analysis Analyz |

Next you should select an analysis method. In the "9 tresheld: J2
'Kinematic Analysis' area there are two options: " Head % Fourier

Head - uses the orientation of the head segment ontydasure responses. This is
suitable for measuring acoustic startle responséssaNOT appropriate for measuring
scoot or routine turn movements.

Fourier - uses the curvature function to measure respongas is much more sensitive
and is suitable for measuring scoots and turns rbot recommended for measuring
startle responses.

Angle threshold - designates the sensitivity for picking up movetse For 'head
analysis' this value means the change in head #&mglenust occur over a three
millisecond window to identify a C-bend. This valdefaults to 8, but can be set to a
higher value for example 16 if spurious movemengsbeing picked up. For 'Fourier
analysis' this value refers to the derivative @f $imoothed curvature function used to
identify the beginning of a movement sinusoid amolutd be left at the default value of
2.
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7. 3. Kinematic Analysis

Once you have set the behavioral thresholds angsamanethod, click '‘Analyze’ in the
'Kinematic Analysis' part of the main window. TKénematic analysis' window contains
information about the kinematics and behavior @hdarva. Each row represents a
single larva, with the number corresponding tortbmber in the video. Clicking on a
row will highlight the corresponding larvae andeviersa.

#il Kinematic analysis
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Ignore for a moment the first column. The othduoms (in order) give the details of the
kinematics of movement bouts. The columns, in orepresent:

cllat - The time at which movement was initiated

dur - Duration of the first movement sinusoid

ang - Change in head orientation during the first moeat sinusoid

mav - Maximal angular velocity achieved by the heathia first movement sinusoid
swvel - Swim velocity (pixels/time)

axis - Maximal curvature at the peak of the first moestnsinusoid

c2dur - Duration of the second movement sinusoid

ang - Change in head orientation during the secondamant sinusoid

mav - Maximal angular velocity achieved by the heath® second movement
sinusoid

axis - Maximal curvature at the peak of the second muarg sinusoid

displ - Straight-line displacement of the larva from ftinst to the last frame..

swcyc - Number of half swim cycles after the first tw@wement sinusoids (if this
number is negative, it means the fish was stilhsming at the end of the recording
period. eg -5 means, there were 5 tail flips,thatfish was still swimming when the
recording finished).

rhythm- Average duration of a swim half cycle

swmag - Average change in body curvature during a swath ¢ycle
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swyaw - Average change in head orientation during a shaihcycle

t end - Time at which movement ended

e sw - Larva should be excluded from analysis becausangdefore stimulus.

e 0 - Larva should be excluded from analysis becausat@ation measurement error
e ed - Larva should be excluded from analysis becanse&lose to screen edge

e tk - Larva should be excluded from analysis becauséipo tracking error.

eyes - Number of eyes found anterior to the head céhtro

tra) - Trajectory of the larvae (angle moved at relatiw initial orientation)

dist - The curved distance moved by the larva

frames - Number of frames for which the larva was tracked

If you are seeing a lot of non-zero 'E-Oj' or 'Eftkore than 10% of responses) then you
need to adjust your video recording or trackingapeeters. Generally improving lighting
and reducing extraneous contrast elements (i.@.vdit improve performance.

For angle and curvature measurements, the valeadiractional - negative values
designate turns made in the opposite directiorositipe values. In our system, negative
values indicate rightward bends. However, as casmand video recording software
often reverse images, you should perform some testseck whether this is true for
your system as well.

7. 4. Behavioral Classification

The first column specifies the type of motor pattexecuted by the larvae in the video.
This is based on the latency and kinematics of mm&veé. The possibilities are

Swvim - Larva initiated movement before the stimulusvaa (often the larva is already
swimming at the beginning of the video).

S.C - A'Short Latency C-bend'. These are Mauthnéated startle responses,
initiated at short latency to the stimulus.

LLC - A'Long Latency C-bend'. These are non-Mauthmesponses, initiated in a
second wave after acoustic startle responses.

Turn - A routine turn.

TurnO - An O-bend.

Scoot - A forward swim.

Burst - A large amplitude forward swim.

J-Bend - A J-Bend (note this is not yet tested and shooldbe relied on).

Excl - Tracking error occurred (see below).

- No movement observed.
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8. Batch Kinematic Analysis

After batch tracking the video files, you will hagedirectory of .sav' files. These are
then be analyzed in batch mode. You can now dleséote.sav program, and open the
bathan.sav program.

4l Batchan: Rapid Behavior Analysis =10] %]

File Configuration  Trials  ROIs  Parameters Tools

[k fiolder I 2 Filter: l

Output folde | I Append Output
Set name: I~ Prepend [ fppend Trials per set: T
Methad 1 5 Rils

& S

i J;E:i[;t;ri:-:] gtl_'rg ETE:JDU Drle.rjtatfnn. l_
" Disolacement LLEC gl i

Thieshald: ia— :ggg:g: 3 |- Setup | Relative to: |_

Subsets:
Include trial nd 4 | & Mone 5 et O 25etB
T Fishit g | Gid[ Block: & None ~TBigek1 Block2

Trendz | Trial subszets

LN | First Frames Rezults |

The basic set of operations to analyze a foldéraaking files is as follows.

1. Select the folder contains the set of trackiles f

2. Select a configuration from the pull-down menu

3. Open the behavioral classification menu by pngsSetup’
4. Run the batch analysis by pressing 'Single’

5. Analyze the results by pressing 'Results’

8. 1. Specifying Input/Output Files

Input Folder
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Click the input folder button to select the foldentaining the set of ‘track_***.sav' files
for analysis. After you have selected the foldteshould appear in the box beside the
button.

Output Folder

Either:

(1) Click the output folder button and select adiory where the analysis files will be
saved.

(2) Enter the name of a folder in the box besidelthitton. A directory of this name will
be created inside the 'input folder' directorya Hirectory of this name already exists, the
analysis files inside will be over-written. Thenm@&you enter here is purely descriptive
and haso influence on how the analysis is performed.

(3) Leave it blank and a name will be automaticablgigned.

Filter

Only tracking files in the input folder whose naoumantains the text in ‘filter' will be
included in analysis. By default this is blanktkat all files in the folder are used.

Append Output
By default this is not checked and a new sub-dimyadf the name specified is created in
the 'input folder' (as described above). If acwey already exists, the files in it will be

over-written.

If this box is checked, then files in the outputi&r are not over-written, rather the new
analysis is added to the end of the existing files.

Set name:

Normally this is left blank. The name of eachisdghen simply the name of the first file
in that set.

For example, if a given group of fish (setA) wastéel 30 times, then there will be a list
of files in the tracking input folder ‘track_setAQGesav ... track_setA e29.sav'. The set
will be called 'track_setA e00'.

When text is entered in this box, the name of #tessexactly as specified in this box.
When text is entered in this box and the 'Prepleuttion is checked, the text is added to
the start of the first file name to create the nafheach set. Thus if the text is 'trpl' then
the name of the set will be 'trp1_setA_e00'. Srhyl if the 'Append’ button is checked,
then the text is added to the end of the firstridene, for example 'setA_e00_trpl".

Several of the ROI functions will automatically nifychis field.
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Trials per set

This number means how many tracking files will beraged to form a single line in the
cl_analysis.trk output file. This number generafpgcifies how many trials each group
was subjected to.

For example, if a given group of fish was testedr@0 trials, you would normally enter
30 in this box. The percentage of fish responahith various types of motor pattern is
then calculated as an aggregate of all trialsif &cross 30 trials, there were 500
analyzable larvae identified and 78 O-Bend evahs%0O-Bend=15.6.

However, note that this number can be used créptivgerform different sorts of
analysis. In the example above, if you set thelmemio 1, then each line in the output
file will represent a single trial. You can thestermine whether there is a change in
behavior over time (habituation or adaptation)teAlatively, you could set the number
to 15, in which case each set of larvae will have lines in the output file, the first
representing trials 0-14 and the second 15-29vailpa blockwise analysis to be
performed.

8. 2. Setup Analysis

Setup the behavioral thresholds by clicking theufgébutton in the middle of the
window. Thresholds are set as in section 7.1 abd¥e 'Behaviors' box lists the current
configuration.

Select an analysis method (head/swim/displacekanthe threshold as for section 7.2
above.

8. 3. Specifying Trial Subsets and ROIs

8. 3. 1. Trial Numbers

Often you will only want to
analyze a subset of trials in an
experiment. For example, you me
have recorded 40 trials for each | " Fish # |_ Grid:l_ _ Block:
group of fish, but 20 trials were

with a control stimulus and 20

trials with a test stimulus, in a pseudorandom sagea. Obviously, you then need to
separately aggregate scores for those blocks.

Subsgets;

Inzlude tal numbers:

0358.6.711.1215,16.18.20.21,22.25,28.30
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To selectively analyze only certain trials, entex list of trial numbers you wish to
analyze. Inthe example to the right, only trihl2,4,8 etc will be analyzed. These
correspond to tracking files ending in'_eOl.sae02.sav', ' e04.sav',' e08.saVv' etc.

8. 3. 2. Trial Presets

Trials RoIs paramete |f there are certain list of trial numbers you fiegjuently, you can

Load Subset save them using the Trials menu. When a listialstis entered in

Save Subset the 'Include trial numbers' box, go_to TrizdSave Subseenter a
name at the prompt. Trial lists are stored in the

ZE‘Z”## 'C:\ftrack\subset_configs' folder. If you ever wishdelete items
from the Trial menu, open the 'C:\ftrack\subset figshfolder and

Default delete the correspinding file.

60x_RMND4_Seta

60 _RND4_Seth In the future, to use that set of trials, just offes Trials menu and

select the set from the list.

It is advantageous to give trials subsets whichuaesl in the same experiment, names
which are alphabetically ordered, as it will laddiow you to automatically cycle through
them (see section XXXX below).

You can automatically generate the list of triaintners when analyzing only even or odd
numbered trials. If you have 40 trials, 20 of whare even numbered, then enter 20 in
the 'Trials per set' box, then select 'Even #' ftben'Trials' menu.

8. 3. 3. Preset pseudorandom sequence

To the right of the trial numbers box are threecghexes.

None - clears the sequence in the trial numbersaboxalso clears whatever name is
entered in the 'output folder field.

The other two boxes are for quickly entering a r@seudorandom sequence, typically
useful if there are 40 recording windows, dividethi2 groups (eg control and stimulus),
which are intermingled according to the sequenteyéhese checkboxes. Activating
the checkbox will enter a 20 number long pseudarandequence in the trial numbers
box and name the output folder.

8. 3. 4. Blocks

If you only want to analyze a the first half ofegsience of trial numbers, click 'Block1'
AND alter the number of trials per set to half toal number entered in the sequence
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box. Similarly to analyze the second half of aussre, click 'Block2'. This saves
having the manually edit the trial numbers box.

8. 3. 5. Gridded larvae

In some experiments you may have individualy
larvae placed in separate wells of a grid, and
wish to analyze them separately. Flote can 7 8 9
analyze larvae in different sized square grids,
with the first larvae being in the bottom left
corner. Be careful if the images loaded into
Flote are flipped relative to the 'real world'! 4 5 6

It is not actually necessary to track the larvae
using the grid option (see section 3.4.). When
running analysis with a grid, Flote will in turn
examine each region of the grid. Thus a fish i} 1 2 3
section 8 of the grid will always be called "-f8"
irrespective of its original number during
tracking. If more than one fish is found in a gs&ttion, then Flote will assume that the
additional fish represent contrast elements migified as fish. If you have set the
tracking parameters correctly, these should gelydraleliminated because they do not
have the correct number of eyes - you should be taltiweak the ‘eye finding'
parameters so that incorrect contrast elements feree'eyes'. But if Flote cannot
eliminate additional fish in a grid element usihgstprocedure, then it will generate an
error for that grid element in that trial. To skerrors are being generated in this way
during analysis, turn on the ParameteReport Track Errorsption.

8. 3. 6. Regions of interest

In many cases it will be of interest to know whetlagvae at a certain angle relative to a
stimulus, or in a certain position within the tagtarena behave differently from other
larvae.

Rlls You can choose to analyze only larvae of a certain
Orientation: | orientation by entering the range of orientatiooseptable
Psition: ||— in the ROI box. Th_e format is [mid-o_rienta_tionnm] in

_ degrees. So entering 90,45 means including onhadain
Relativeto: | the orientation range 45 to 135. Similarly entgi®10

would include only larvae whose orientation washie
ranges 355-360 and 0-5.

It is crucial to be sure of how your image of thsting arena is transformed during

imaging. Most systems produce a 180 degree rotatahe time the image is loaded
into Flote:
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Real world

Flote (inverted by camera)

Rezo @ oo [0512] [512512]
VR S E— Wl =suil} 180
[512,512] [0.512] [0,0] [512,0]

" gD 1
., \I n’ \‘

Orientations in Flote are anticlockwise, with O s horizontally to the left (in Flote,
corresponding to horizontally to the right in tlealrworld). However in some cases you
may want to examine larvae of an orientation re¢ato a different angle, or relative to a
specific point.

Orientation relative to an angle: Entering a single number in the 'relative to' boakes

the orientation ROI relative to that orientatidfor example if you specify a range of
orientations '90,20', then normally larvae whoserdation is between 70 and 110 would
be included. But if you specified 'relative to', #%en larvae between 115 and 155 would
be included. Basically this just rotates the figtdthat the specified angle becomes zero.

Orientation relative to point: Entering coordinates (eg -100,256") in the 'reéatd’ box
will include larvae whose orientation is in the ganrelative to the angle from the
position of the larva to the specified point.

You can also specific a region of interest in xp@iinates in the 'position’ box. The
format is [start-x, end-x, start-y, end-y]. So é&xample entering '50,200,60,250" would
only analyze larvae in a box starting from poir,@®) to point (200,250).

The number of larvae in a ROI can be found by Ingkn the xya_analysis.trk file in the
‘ArealD’' column. The percentage of larvae in tid B in the '%inArea’ column.

8. 3. 7. ROI Presets

ROIs

» Orientation: 2 segments

You can have Flote automatically analyze presestaet
regions of interest using the ROI dropbox. If yheck
one of the options in this dropbox Flote will deth
following:

Parameters

Orientation: 4 quadrants
Crientation; 5 sectors (180deq)
Crientation: § sectors (360 deg)
Position: ® segmenks
Position: % segmentks

| Ilzer defined

1. Enter a prefix for the ROI in the 'Set namdtfie
2. Enter the corresponding ROI in the ROI box.
3. Run an analysis.

4. Check the 'Append output' box.
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5. Return to step 1 and cycle through until all Rk the set are analyzed.

You will normally need to have clicked the 'Prepestteckbox so that the prefix in the
set name field is added to the beginning of theeaather than become the entire name.

Preset ROIs are available, covering sets of orilemsias well as regions of the testing
arena. These are illustrated below. Keep in rthiatlthe diagrams representing
orienation groups may be confusing. For exampilettfe ‘Orientation 4 quadrants' ROI
the diagram does not indicate that '_twd' larvaetlaose on the left of the testing arena, it
illustrates that'_twd' larvae are those fish *ahgwve* in the arena, which have an
orientation from within 45 degrees of 0.
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Orientation: 2 segments

Real world

Flote (inverted

by camera)
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Orientation 8 sectors

Real world Flote (inverted by camera)

Position: X segments

Real world Flote (inverted by camera)

Position: Y segments

Real world Flote (inverted by camera)
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If you select the 'User defined' option, Flote witlen the file c:\ftrack\paths\userroi.txt.
This file should be organized as series of linesnleach line specifies a the name of an
ROI and its parameterbtame; Orientation ROI; Position ROI. All these elements must

be present. For example to analyze first the @Peteangle centered on orientation O,
then the 90 degree angle centered on orientationdu&r the entire recording field, the
file could contain these two lines:

Sectl;0,45;0,512,0,512

Sect2;180,45,0,512,0,512

8. 4. Setting options

8. 4. 1. Analysis Parameters
|
When saving kinematic data to the summary.trk file, _| CEVET SRS
Flote can either save changes in orientation anchture | ¥ Rectify Neg ¥slues
as values greater than zero (ie the absolute mafgitor | Ink=aral €1 Analz
as values greater than zero for leftward turns,|essl v Use fuds For LR Dir
than zero for rightward turns. Toggle the Smooth Orient Jumps
Parameters-Rectify Neg Value®©N to save only the Report Stationary

absolute magnitudes. Report Standard Devs
Report Track Errors

IUInadjusted inikiation counks

8. 4. 2. Reporting Options v Adinst % For SLCs

Parameters 1. Report Stationary - By default, Flote does netude

v Rectify Neg Values information about stationary larvae in the sumakyfite

w Integral C1 Angle because this makes the file very large and botthbat

v LUse Axis For LR, Dir analysis and subsequent results analysis can become
smooth Crient Jurmnps extremely slow due to the large amount of datadpein
D R m— manipulated. However, information on larvae that a
Report Standard Devs deemed to be 'stationary' can be necessary whéariparg
Report Track Errors displacement analysis, so toggle this on to getrmétion

about the x,y coordinates, orientation and derudity

IUnadjusked initiation counts .
stationary larvae.

v Adjust % Far SLCs

2. Report Standard Deviations - Output cells conssandard deviations instead of mean
values.

3. Report File Errors - Track files are sometimesbrrupted, unable to be opened or
containing scrambled data. Flote will simply skpse files, however, when checked,
this option pops up a window detailing which filgere corrupted. You should go back
and retrack these files (just delete the trackileg faffected and initiate tracking again -
Flote will skip over trials where a tracking fil&ists and just track trials where there is
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no corresponding tracking file). However occasliyngou will want to ignore the
scrambled files and turn off error reporting - ueck this option to do so.

8. 4. 3. Calculation Options

Paramneters There are three ways that initiation frequencesbean

v Rectify Neg Yalues reported.

v Inteqral C1 Angle

w Use Axis for LR, Dir 1. The default way is to simply report the percgataf
Smoath Qrient Jumps maneuvers of a given type (ie SLC, LLC, O-Bend.etc)

This represents the fraction of these maneuversrobg

] out of all analyzable embryos spotted.

Report Standard Dewvs
Report Track Errors

2. 'Unadjusted initiation counts' - toggle thistorget the
Unadjusted initiation courts ‘raw' number of maneuvers observed, ie NOT divigethe
v Adiust % for SLCs number of analyzable embryos. This is mostly usghen
estimating directional bias - you may decide tolede items where too few maneuvers
were observed to give reliable data.

3. Adjust % for SLCs. Normally, the number of LLSgeported as the fraction of
larvae executing a LLC out of all analyzable larttzat did not perform an SLC.
Remove this toggle to get the number of LLCs asetibn of analyzable larvae.

8. 5. Loading and saving configurations

<To be written>

8. 6. Output files

The sub-directory created by batch analysis costiar output files plus a 'config.txt'
file which contains a record of the settings usedlie analysis.

1. summary.trk - Contains kinematic data on th&t two bends (eg C-Bend and counter-
bend) for each movement episode measured. Thitals-separated text file that can be
opened in excel.

2. swim_summary.trk

3. cl_analysis.trk

4. xya_analysis.trk

These files can be opened in a spreadsheet (Eorcaded as input for the kinematic
analysis

A quick overview of the contents of each of thepoaifiles
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summary.trk

This file contains information on kinematic propestof the larvae during the first two
peaks of the waveform of movement. For examplestartle responses, this file contains
information about the C-bend and Counterbend.

A B | ¢ | b | E | F
1 |anadatadh: Response Analysi Date: Mon Jul 23 11:30:47 2007
2 |File Fizh Resp Fpos Yoz Orient
a3 [dA_i0000ps_00s_e0S 0000 2 20 15103 127182 335022
A (g i0000ps_00s_e03_0001 E 2 330054 223738 340032
5 [dA_i0000ps_00s_e03_0003 10 2 374347 2ME028) 210553
B [da_in000ps_00s_e03_0005 3 3109.051 | 130864 35054
7 |dA_in000ps_00a_e0s_0006 4 3 870844 | 144805 320008
8 [dA_i0000ps_00k_e0sS_0000 7 3 261097 250957 359992
9 |dA_i0000ps_00k_e0sS_0000 11 30 281078 327320 218057
10 | d&_i0000p3_00k_e03_0001 G 2095323 246151 393429
11 |da_i0000p3_00k_e03_0001 g 2 231483 2824971 320214

Column A specifies the video sequence in whichetrent occurred. Here, a prefix was
used so the file name begins 'dA ' instead ofktracThus first event was in the folder
'l0000p3_00a’. The next section'_e03' meandiinag analysis, a subset of videos
must have been selected, starting with the foudbossequence in the whole stack.
More usually it would read ' _e00' meaning that gsialbegan with the first video in the
stack. Finally,' 0000’ refers to the number eftideo within the subset selected. In
this example, analysis began with the fourth stduks 0000 also the fourth stack. The
next line is'_0001', which would refer to thetiftideo in the stack.

Column B specifies the identity of the fish in thdeo. Once you've identified the video
sequence and fish, you can return to Flote andhtate movement of that particular fish.
As an additional check, compare the initial (x,9painates and orientation of the fish
(columns D,E and F).

swim_summary.trk

This file contains information on kinematic propestof the larvae during swimming.

cl_analysis.trk

This file contains information on the behaviorasdification of the larvae.
File - the name of the first file in the set of trialsmbined for analysis.
TotlDd - total number of fish identified over all theatis

E-Ed - the percentage of fish excluded from analyses tdubeing too close to the edge of
the image.
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E-Jmp - percentage excluded because orientation analgsisinreliable (usually poor
image quality)

E-Trk - percentage excluded because due to a trackiag er

E-Sw - percentage excluded because larvae was alreadygibefore the stimulus time
E-Eye - percentage excluded because the object didawat the specified number of eyes
in the first frame of the recording. Note thastban be a very useful measurement, as if
you specify that the eyes should be '2,2' and @anédent that there are no odd contrast
elements in the video, then you have a measutgeaiumber of larvae that are not
perfectly upright. This is thus a nice surrogateviestibular function.

TotAnd - total number of fish analyzed after excluding do errors

React - percentage of fish performing any response rfoé stationary)

SL.C - percentage of fish performing an SLC

LLC - percentage of fish performing an LLC

AllTurns - percentage of fish performing an O-Bend, R-Tard-Bend

R-Turn - percentage of fish performing an R-Turn

O-Bend - percentage of fish performing an O-Bend

J-Bend - percentage of fish performing a J-Bend

Swim - percentage of fish performing a Scoot or Burst

Scoot - percentage of fish performing a Scoot (slow swim

Burst - percentage of fish performing a Burst swim

Other - percentage of fish performing a response nattitigble by Flote

SLC(r) - the percentage of SLCs initiated in a rightwdireéction

LLC(r) - the percentage of LLCs initiated in a rightwdrntection

AllTurns(r) - the percentage of (Obends+RTurns+JBends) iadiat a rightward
direction

RTurn(r) - the percentage of R-Turns initiated in a rightivdirection
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OBend(r) - the percentage of O-Bends initiated in a rightirdirection
JBend(r) - the percentage of J-Bends initiated in a rightixdirection

ct(r) - the percentage of Scoots initiated in a rightivd@irection (note - this is NOT
reliable, it is included for future improvements)

Bur(r) - the percentage of Bursts initiated in a rightwairection

BiasSLC - the tendency for SLCs to be initiated in thesdiion of the target. For this to
be useful, you need to specific the position oftdrget (see section 8.3.6). This is
calculated at 2*[%SLCs initiated in the directiditloe target]-100. Thus a score of +100
means all are target directed, -100 means all\aag &rom the target.

BiasLLC - the tendency for LLCs to be initiated in theediion of the target

BiasTurn - the tendency for (OBends+RTurns+JBends) to iated in the direction of
the target

BiasRTurn - the tendency for R-Turns to be initiated in tection of the target
BiasOBend - the tendency for O-Bends to be initiated indirection of the target
xya_analysis.trk

This file contains the information that can be usethake simple analysis of distance,
speed and orientation of the larvae.

File - the name of the first file in the set of trialsmbined for analysis.
TotlDd - total number of fish identified over all theats

TotAnd - total number of fish analyzed after excluding do errors
ArealD - total number of fish analyzed that are in thel B@d/or Sector
%inArea - percentage of all fish that are in thel Rd/or Sector

XVec - mean horizontal displacement from center ofaallae identified where -1 and +1
represent the extreme edges of the recording field.

YVec - mean vertical displacement from center of allda identified where -1 and +1
represent the extreme edges of the recording field.

AVec - mean orientation of the larvae relative to acdjssl orientation or target position.
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T-Dist - mean distance of larvae from the target position

AVecl -
AVecR -
XVecS -
YVecS -
AVecS -
SwVec -

9. Results Files

10. Results Analysis

Flote contains a simple utility to quickly graphdamssess the significance of difference
between experimental groups.

Please note - this utility is for a quick analyany!!! Flote does not give you the
flexibility to appropriately set up or validate tb&tistical tests used. Yooust import
the data into an appropriate statistical packdge3AS or SPSS.

10. 1. Loading Data

Upon entering the statistical package, you are ptethfor a file to load. Select any ".trk'
file generating by the analysis package. At ametyou can load a new file by selecting
File—Load

The currently loaded file is shown just below therm bar. At any time this file can be
refreshed from the hard drive by selecting FilReload File

In some instances you may have multiple experimaittsthe same

10. 1. 1. Window Controls

On selecting File>Quit all windows will be close@xcept for thePrinter Out window.
This will remain so that you can add

data to the printer output window from g Ol x|

other analyses. Name - TotiDd [TatiDd)
track_buffer00_00a_e00-F1 - 18.0[ 18.0)
track_buffer0l_00a_e00f2 - 19.0[ 19.0]
frack_butferd0_00a_e00-(3 - 20,0 [ 20.0]
rack_buffer00_00a_e00-f4 - 19.0[ 19.0]

10. 1. 2. Groups wWindow Mrack_bufferD0_00a_e00-5- 2000 0o
Mrack_butferd0_00a <00 =
rack b - .- 140 14.0)
S e _Ma_e00-8- 1700 17.0

™ i

¥ Show Mames

Sort I Delete




This window shows the groups that match the seles¢¢together with the value of the
parameter selected.

If no sets are selected then all groups are display

If a range of values has been selected, then Hpagiis sorted so that groups inside the
range of values are shown, with a *' mark in frohtheir name to show that they fall
within the selected range.

If the range of values was selected for a paranweher than the one currently being
displayed in the graph, then the brackets on tjtg show the value for the parameter for
which the range was selected.

The Sort button will reorganize the list alphabeticallyhélDeletebutton lets you
eliminate a group from further analysis (see beloWheShow Namescheckbox (not
implemented fully) by default is on, allowing yomdee the group name and value.
When off, it just lists the values for the seleaedup to facilitate cut/paste into
statistical packages.

10. 1. 3. Printer Out @& Printer Out... =] E3

Oukpuk
If you click on this window with the left mouse o, the
contents of the main window will be copied to thimfer out at 1
that position of a 2 row by 4 column grid. If yolick on the
printer out window with the right mouse button, ttestents of
the main window will be copied at that positionaod row by 8 3
column grid.

To send the contents of this window to the prirgefect
Output—Print from the menu at the top. Similarly, the outpu
window can be saved as a ".tif' file or copiedh® tlipboard
from this menu. To clear the contents of the wimdselect
Output—Clear.

N
0o & B~ N

10. 2. Define sets

The analysis package is built to allow you to gadilmp a set of ‘groups’ (which may be
plates, single fish or individual movement respeh&eto a 'set'.

Sets are defined on the basis of having a commquesee of alphanumeric characters in
their name. Thus if your have a series of growghed

A_con_00a

A _con_00b

A_con_00c

A _met_00a
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A_met_00b
A_met_00c
B_con_00a
B_con_00b
B_con_00c

Go to_Define Setand select the number of characters from the endnysh to ignore
when matching names. For example, if you selgécthen the first 8 characters will be
used to define the group identity. In the exangiieve you would end up with 3 sets:
A_con_00, B_met 00 and B_con_00, each of whichughes 3 groups (the first set
would be A_con_00a, A_con_00b, A _con_00c). Alteznely use Define SetsEnter
Endto open window with the first group name. Clickhwn the group name to show
how many characters from the beginning should biemed.

Now, the 'sets' droplist will contain just the sitst have been defined in this way. If you
select a given set, the matching groups will appe#re 'subsets' window.

Important . Before defining the sets, you should remove gsdhat you want to exclude
and setup parameters that help you to define apptefsets - see below. Strange things
can happen if you don't define the sets first.

10. 2. 1. Remove unwanted groups

Before defining sets, remove any groups that yontwadiscard from further analysis.

To delete a single group, in the subset windovectel group to discard and press the
delete button.

To delete groups whose values lie outside a ramgethe histogram window to select a

range of values for a given parameter, by holdmgmouse button down and dragging
across the range you want, then press the 'ctidrbut

10. 2. 2. Parameters to identify sets

Under 'Define Sets' a number of options provideilfiéity in identifying sets.

10. 2. 2. 1. Single Fish

This should be checked if you have an experimenthith each group is actually a
single fish so that the name of each group contastsing '-f1' (for fish 1) to -'f9' (for
fish 9). If this is checked, Flote will automatigadiscard the -fX" information in
attempting to make sets. If you do not have sifigte its OK to leave this checked
because if Flote can't find the string -fX' thewill ignore this option.
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For example, if you have eight groups: '‘Con' angh"Feach containing 4 fish, then your
group names will be 'Con_e00-f1', 'Con_e00-f2'n'Gx0-f4' etc. By selecting this
option, Flote will ignore the '-fX' so that you caasily define two sets 'Con' and 'Exp'

10. 2. 2. 2. Smart Names

When this is checked, Flote will attempt to guéssriames of the sets. In doing so, it
assumes that each group name begins with the &nae§_' and it will remove this string
from the group names.

Smart namesis automatically turned off in several cases

1. If you used the 'prefix' option when running #raalysis, then the word ‘track_" will not
be present and Flote will turssnart namesoff

2. If you are analyzing the summary.trk file orextldata where the group name does not
end in -fX" (for fishwise analysis) or '_eXX', th&lote turnsmart namesoff.

This option can be a source of grief - if you findird things happening, like groups
being ignored, or datapoints lost, the first thiadry is turning this off. 'Smart names' is
not so clever.

10. 2. 2. 3. Ignore Case

Self-explanatory

10. 2. 2. 4. First +1

Sometimes you want Flote to define sets, ignorivegfirst character in the string. An
example: you analyzed the data according to quéjrand now you have a 'Rsid_' group
and a 'Lsid_' group. For the purpose of analy#iegrightward bias of turns, its desirable
to analyze Rsid and Lsid separately, so you woafthd the groups as normal. But for
the purpose of analyzing the turn-bias toward &ngdt, or movement kinematics for
side-oriented larvae, it is better to have the Rsid Lsid measurements in the same set.
So you can check tHarst+1 option and take the average of the Rsid and Lsid
measurements.

10. 2. 2. 5. Matching groups

| Define Sets Behavior Vi i vo\; enter a string in the ‘'match’ box, then agigups matching

Al that string will be included in the sets. Othemrs simply ignored.
-1 (dA_00a_e0)

-2 (dA_00a_g)

-3 (d&_00a_)

-4 (d&_00a)

-5 (d&_00)

Truncakte k
Enter End 49

10. 2. 3. Other ways to identify sets

Manually
By position




The Define Sets menu has two special modes fonidgfsets.

Sets can be defined 'manually’. Selecting thigpogirings up a window asking for a
string to match 'Set 1' with. Any group which niegs the text you enter here will be part
of 'Set 1'. Continue entering strings that you tiammatch each set with. When you are
finished, leave the box blank and hit 'OK'. Thgion also allows you to give the sets a
name, by entering the match string, then a comineg, the name you want the set to
have. For example entering 'a0la,First' will matitiyroups with the string 'a0la’, and
the set will be called 'First' (in the bar graphdap

Sets can be defined 'By position'. This is usetuen larvae are in individual wells in a
3x3 grid and were analyzed with the grid optiorll the 'f1' larvae will be a set, the 'f2'
larvae another set and so on. This is mostly agdrto allow quick verification that
position in the array is not influencing behavior.

10. 3. Changing the Plot Window Format

Right click inside the plot window to set the tidéthe window. To clear the title, right
click and leave the box empty.

To change the color scheme use the controls ikdh@matmenu. You can individually
set the:

Background - color of the blank area behind the plot

Lines - color of the plot axes and text

Sets - color used to plot the value of all the sets

Selected - color used to plot the value of the selected set

Subset - color used for plotting when a sub-range of gealbhas been specified.

Six preset color schemes can be quickly specifidtese are the options at the top of the
Formatmenu. The schemes are described as Sets/Sefadbsdf. Selecting
White/White/White automatically turns on the

Text size: The format menu also allows you to cleathg size of the font used
(Format—Large Textor Small Text) The large text option is particularly useful whe
plots are being added to the printer output windowalf size. The font can also be
changed to a pseudo-Helvetica format for a chicsS\waok.

Thick lines: The weight of the lines can be chanigea thicker appearance, using
Format-Thick Lines also mostly useful when plots are being addetd@rinter
window in half size.

50



Outline bars: In graphs where the data appeararaghistogram, bar graph,
box/whiskers) selecting FormaiOutline will circumscribe each bar with a black line (or
whatever color you selected foimes above).

Grid: Horizontal grid lines can be added to the plpselecting FormatGrid.

Names vertical: In bar graph mode, if there areyrzars, the names of the bars often do
not fit underneath them. Names can be insteaeg@laca vertical direction on the left
side of the bar by selecting Formaiames vertical

Error bars: In graph modes with error bars, the lbae plotted only upward by default.
To have errors bars also stretching downward s€lechat-Bidir err.

The size of the plot area can be changed by drgdgaedges. To restore to the default,
select Format-Restore To grow or shrink the plot area by standard am®select
Format->Shrinkor Enlarge Similarly Show-Resizehas some options for controlling
size.

Set the X and Y axes using Formebet X-Axisand_Format>Set Y-Axis To restore
the axes to automatically scaling, enter nothinthendialog box. A shortcut to restore
axes to auto-scaling is to click anywhere in theadp the left of the Y-axis.

10. 4. Histogram Plots

In histogram mode, datapoints are binned accorgdinger-specified bin dimensions.
The X-Axis shows each bin, displaying the high-ealar datapoints in that bin.

Set the bins of the histogram using the three btWes, 'Size' and 'Bins'. In addition, a
first bin and a last bin will be automatically geaied for datapoints lying outside the
specified set of bins.

Min - the highest value for the first bin. ThislMmclude all data points less than or
equal to this value. For example if set to 10,fitst bin will include all data points less
than or equal to 10.

Size - the width of each bin (except for the fastl last). For example if set to 20, then
in the example above, the second bin will inclulie@&a points greater than 10 and less
than or equal to 30.

Bins - the number of bins between the first antlbass. Thus if this is set to 10, then in
the above example, the 12th bin will be for datafggreater than 210.

10. 4. 1. Selecting Bins

51



To select a group of bins, hold the left button draly the mouse across the columns you
want to be selected. To select everything less ghgiven bin, release the mouse button
beside the left-hand Y-axis. To select everytlgnegater than a given bin, release the
mouse button beside the right-hand Y-axis. Ortdbeight of the screen will be
displayed 'where ..." indicating the subset setecte

10. 4. 2. Comparing Sets

By default, the distribution of a given set is stipgosed on the overall distribution of
all data points loaded. To examine a set in igmlaincheck the 'Background' checkbox.

10. 4. 3. View Presets

The four buttons on the left are available to sgpr@set views, including the parameter
and bin setup. A keyboard shortcut for these Ingtis available: press 1,2,3 or 4 to
select the corresponding bit.

To set the views use the Views menu - the seleatidibe set to match the current
configuration.

10. 5. Data points

This plot shows the individual group values forteaet, stacked vertically. Dots are
randomly displaced in a horizontal direction to m#keasier to see and avoid dots
overlapping. Click in the graph to redistributeikontal positions.

10. 6. Bar Plots

Bars are displayed in the order that the sets appehe Sets droplist. To change this
order, select a set and use thandR buttons to move the set up and down (=left and
right in the bar graph) in the droplist.

10. 6. 1. T-tests between sets

To compare all other sets to a selected sets,adgiyl the Show»T-testoption. A
shortcut is to double click on a bar - this willess# that set, and toggle the t-test option
on. Single click on another set to make it the parison set. To clear the comparisons
toggle OFF the ShowT-testoption, or for a shortcut, click just to the rigiftthe left Y-
axis.
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To compare two sets, hold the left mouse buttonrdalaove the first bar and drag across
to the second bar then release the mouse button.can do this multiple times. To

clear the comparisons, hold the left mouse buttbilewdragging the mouse from beside
the left Y-axis to the right Y-axis.

All t-tests are two-tailed and assume equal vaganc

By default, t-tests p values are directly giverowever by toggling the Showp values
option, you can display symbols for different lessef significance.

10. 6. 2. Single factor t-tests

To compare the mean of a set to a specified vaklect_Show»>One sample.t A dialog
will open asking the numerical value for comparison

10. 6. 3. T-tests between parameters

To compare the mean of a given parameter for ds#ie mean of another parameter for
the same set, select a secondary parameter bsingg right droplist. The two
parameters will then be graphed side by side fon sat.

10. 6. 4. T-tests within parameter, different range

This is accomplished by selecting a range of valoesne parameter in histogram mode,
then in bar graph mode, setting both the paranaetgisecondary parameter fields to be
the same.

Best explained with an example. You want to coraphe duration of C-bends for left
directed turns and right-directed turns. So yeriggmed analysis with the
Parameters-Rectify Neg Value®ption OFF. You open the summary.trk file an@aft
eliminating datapoints and defining sets as uswumal,do the following:

1. In histogram mode, chose the Angle parameter

2. Select the range of values less than zero Wdirgpthe left mouse button down slightly
to the right of the left Y-axis, then dragging a&sdo the side of the bar in the zero value.
3. Go to the bar plot mode and chose the duratoarpeter - you should now have a
simple bar plot showing the mean of the duratiarefich set.
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4. In the top right corner, set the secondary patanalso to be 'duration’ - the original
bar will change size slightly because it now oriip\ss the duration for angles greater
than zero (and the n below each ba nE eooeH o7 QI 0 SC
will only reflect the number of 1
groups with angle greater than zero
In addition a new bar will appear
beside it, showing the duration for 2]
angles less than zero. The label
beside the right axis will reflect this. | -
5. Select ShowsT-testto getthe p
value of comparisons between bars -
§
Note: for this to work properly you "
must use a 'standard size window'
(Format>Restorég.

[eb]  Subsat: o (<30)

10. 7. Trend Plots

10. 8. Bar Trend Plots

10. 9. Box Plots

The box marks the interquartile range (i.e. 25%5®&0) with the median as a black strip
across the box. The whiskers represent the raihglémints except for outliers, where
outliers are points 1.5x the IQR below the firsadile, or above the third quartile. There
IS no current option to represent the outliers.

To see what the values for the whiskers, intergeadange and median are, select
Show—Average/SD

10. 10. Scatter Plot

10. 11. Circle Plot

54



10. 12. Angular Plot

The angular plot takes the groups and plots theseet®rs on a circle, evenly distributed.
This is most useful as a visual aid to comparingaler analyzed using the 8 sector
region of interest mode. The color of the baraatks the value, with the scale bar in the
right hand corner showing the range of colors andesponding values.

Use the FormabThick Linesoption to toggle the size of the bars.

Use the Show»Average/SDoption to toggle the name and value of the bars.

Change the Y-axis scale to alter the color gradient
Real world Flote (inverted by camera)  Angular Plot

1] 270

150 {— et} O D G| @ 180 180

270 1] 270

An advantage to using this method of analysisas tiie 8 sectors now are visually
displayed in the same orientation as the real world

10. 13. Saving Data

The File menu offers several options for data autdunere are two |

options for obtaining a copy of the graphical windo File Format Define Se
Reload File Il
Save Image- save window as a tif file _
Load Fish
Copy Image- copy window to clipboard for pasting elsewhere iEE:;: E::ams |[
Load Histo
There are additional options for saving tab sepdrtext files of the -
data set. Save Image
Copy Image
Save Data Set save a tab separated (ie excel compatible) fille w Save Data Set
the current data loaded. This is an easy wayue data after Save Statistics
deleting groups and data points. The file is foumthe currently Save Means
working folder, and has the same name as the diyieaded data 5ave Hist Data
set, with the string '_data' appended. SIED (FETEEE
Quit

Save Statistics save the current mean, standard deviation (&,SE '
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whichever you are currently showing) for all cuttgmlefined groups as well as the
ANOVA between them. The file is found in the cuttgrworking folder, and has the
same name as the currently loaded data set, vathtting ' _anova' appended.

Save Means first saves the mean of all groups into a néevdppended with the string
' mean’. Then loads that file into memory.

Save Hist Data- saves the histogram values for the current par@nexamined and for
the currently selected group. The output fileasne of the current data file appended
with the name of the selected parameter, and i{eeted group, then '_histdata’

Save Percent for each group, looks in the current parameter @unts the number of
data points selected by the user, calculates wdraeptage of all values they constitute
and saves the result in a new file named aftectinent working file, appended with the
currently selected parameter and '_percent'.

10. 14. Keyboard shortcuts

1,2,3,4 - setview

space - clear the selected group
delete - remove the selected group

a - show anova

b - bold

m - toggle SEM/STD

p - toggle paired t-test

t - toggle show t-test

v - toggle vertical name plot
y - set Y axis

Z - move group left
X - move group right

, - plot previous parameter
. - plot next parameter
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11. Analyzing Data

11. 1. Analyzing Movement Frequency

11. 2. Analyzing Movement Directionality

11. 3. Analyzing Movement Kinematics

11. 3. 1. C-Bend and Counterbend Kinematics

11. 3. 2. Swim Kinematics

1. Select the type of maneuver whose kinematicswish to analyze by
checking Behavios [Select scoot/burst/rturn etc]

2. Remove swim bouts with zero or one tailflip et is no information to
analyze in these swim episodes by checking Behax&wCycles

3. Select the kinematic parameter of interest.

Note, when analyzing the number of half swim cygcieis important to
remember that in instances where the fish wassstilnming at the end of the
recording,Flote designates the number of swim cycles as a negatinder.
There are two ways to deal with this:

1. Enter histogram mode, and select only those swyitte values >1 then click
the /Sel/ button to remove all the incomplete swyules.

2. Click the 'Abs’ box on the left side of the memea. This will convert all
negative values into the positive value (eg, ifnlnenber of swim cycles is
negative 5, it will become positive 5).

In situations where there is a very large proparbbincomplete swim bouts
(such as where you use a small recording windowyhare the larvae are
extremely hyperactive), neither method is idealdioalyzing the number of
swim cycles and you should be careful to presentltita as the number of
swim cycles observed NOT the actual number of seyoles the larvae
executed.
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12. Other Applications

12. 1. Analyzing long time series data

For tracking, Flote loads a series of frames in&naory, then performs tracking,
identifying all the larvae in the initial frame, gignating each with an identifying number
then tracking each larva across all frames loadedmemory. It is also possibly to track
very long time series, without uniquely identifyitige path of all the larvae in the
recording. For example, you may have a 15 minitteos recorded at a low frame rate
(for example 50 frames per second, so a total 80@3rames), with larvae continuously
entering and exiting from the recording field. gimduce a picture of the paths made by
the larvae during this recording, setup batch aisity track 45000 events of 1 frame.
The tracking directory will then contain 45000 k&g files. You can use the
Tracking—Convert tracks to texXtinction to convert the tracks to a series of tab-
separated text files containing the x,y positiohthe larvae in each frame. Set the
Tracking—Convert tracks to single terption so that all the tab-separated x,y positions
are gathered into a single output file: C:\ftratik\@acks.txt.

Open this file with a plotting program and generatzatter graph of the x,y coordinates.
So long as your frame rate is fast enough, thisilshgroduce an image containing all the
tracks of all the larvae entering or leaving theording field over the 15 minutes.

Note that if you have only a single larva in thgtiteg arena, you can easily calculate
information about the speed of movement using aeasjgheet.

13. Troubleshooting

| can't load files into Flote.

Solution 1. Try turning on the 'FHeAlphanumeric file order' option. If files now load
ok, then your naming convention is not exactly wiflate is looking for. You can still
operate Flote normally, but it will take longeréad each set of frames.

Solution 2. There is a known bug where if you hesain windows open, the file load

function fails. This often occurs if you have #wom window or the time-series graph
window open. So close these windows and try laadllas again.
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Tracking is very slow.
Make sure than "TrackirgRapid tracking' is turned on.

Too many heads are being found

1. Make sure the fish are the only contrast elementhe field
2. Either reduce the size of the image so thatisheare of about the recommended size
(ie about 50 pixels in length)

3. Play with the head centroid finding controlslascribed in section 3.1 to fit your
image.
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